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ABSTRACT

3D LOCALIZATION OF CYTOSKELETON IN MOUSE SPERMATIDS USING

STOCHASTIC OPTICAL RECONSTRUCTION MICROSCOPY

It is estimated by the World Health Organization that globally 186 million individuals live with

infertility. Studies have shown that cause of male infertility is unknown in 30 to 50% of the cases.

Over the last several years teratozoospermias have been investigated and have been backtracked

to events in spermatogenesis. The development of the acrosome and the manchette, protein and

vesicle transport in spermatids, and sperm head shaping are crucial steps in the formation of healthy

sperms. The cytoskeleton in spermatids plays a crucial role in shaping the sperm head. The

acroplaxome exerts forces on the nucleus and gives the mammalian sperm head its species-specific

shape, and also facilitates the proper attachment of the nuclear cap called the acrosome, containing

the enzymes required for sperm penetration of the oocyte. The manchette should be intact and

formed properly to have shortened diameter as spermatids differentiate so that it can constrict the

base of the nucleus to shape the head, and also facilitate the transport of cargo to the base of the cell.

Thus as studies have confirmed, the disruption in the organization of the cytoskeleton is a concern

for infertility. Hence it is crucial to learn more about the cytoskeletal structures in spermatids. The

goal of this thesis is to 3D localize these structures.

The major structures we are interested in are the acroplaxome and the manchette. For this, we

use a super-resolution microscopy method called Stochastic Optical Reconstruction Microscopy

to image spermatid cytoskeleton. Our experiments confirmed the presence of α-tubulin in the

manchette and that of F-actin in the manchette and the acroplaxome, as previously observed by

researchers with 2D confocal images. We observed that the manchette reduces in diameter and

progresses to the caudal portion of the cell at the later steps of differentiation and that the structure

forms completely at step 10 and disassembles after step 14.
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Chapter 1

Introduction

It is imperative to have good quality and quantity of sperm for successful fertilization. Condi-

tions that cause abnormal sperm shapes solely or simultaneously in the head, neck, midpiece and

tail are called teratozoospermia [1]. One of the most common and severe cases of teratozoosper-

mia in humans is globozoospermia where the sperm head is round instead of the typical oval shape.

This condition may also accompany by a complete lack of acrosome. The acrosome contains the

necessary enzymes to penetrate the zona pellucida layer of the female oocyte. It is difficult for

a round sperm head to penetrate the egg, especially without the enzymes to traverse through the

membranes of the oocyte [2]. Several events of spermatogenesis have to be perfectly aligned to

ensure a typically shaped and healthy sperm. The process of spermatogenesis occurs in the testis in

a compartment called the seminiferous tubule, which has a complex epithelium and fluids. Sertoli

cells are a group of its epithelial cells that provide support and nutrition to the developing germ

cells. Due to its crucial role in the normal progression of spermatogenesis, germ cells cannot be

successfully developed in vitro in a culture dish. Since mice have a very similar genome to hu-

mans and hence have many genetic defects identical to humans, mouse models are used to study

the causes of male infertility [3]. It is to be noted that mouse spermatids have hook-shaped heads,

unlike human spermatids.

The following sections discuss the process of spermatogenesis, the cytoskeletal structures that

are crucial in ensuring fertility, and the super-resolution method we use to localize the cytoskeleton

in spermatids.

1.1 Spermatogenesis

Spermatogenesis is a complex process by which primordial germ cells develop into spermato-

zoa. The process advances from the base of the seminiferous tubule to its lumen while in constant

contact with Sertoli cells, as seen in fig1.1. Spermatogenesis is initiated at puberty and is charac-
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terized into three distinct phases. The first phase is the proliferative phase, where spermatogonial

stem cells (SSC) undergo mitotic division to form undifferentiated spermatogonia to replenish its

population and differentiated spermatogonia for the production of sperm cells. The self-renewing

ability of SSCs ensure continuous production of spermatozoa [3]. Proliferation ends in a premei-

otic DNA replication resulting in primary spermatocytes.

Figure 1.1: Schematic representation of the mouse spermatogenic process from the base to the lumen of the
seminiferous tubule. Spermatogonia lies in the base and by proliferating produces different types of primary
spermatocytes. The secondary spermatocytes are further down towards the lumen and undergo two meiosis
to become round spermatids. Spermiogenesis occurs next and spermatids differentiate. From step 8, the
spermatids elongate and towards the end of spermiation, most of the cytoplasm is removed from the cell,
and fully developed spermatozoa leave the lumen of the seminiferous tubule. The figure was taken from
Teves and Rolden 2021 [4] and used under Creative Commons Attribution CC by 4.0.

The second phase of spermatogenesis is meiosis. In the first meiotic division, the primary sper-

matocyte goes through a long prophase including preleptotene, leptotene, zygotene and pachytene

stages, each later stage occurring farther down the seminiferous tubule than the one before. The

2



Figure 1.2: Schematic representation of mouse spermatogenesis. Spermatogonial stem cells undergo mi-
tosis and both self renews its population as well as provide cells for further differentiation. Spermatocytes
undergo multiple meiotic divisions to generate haploid round spermatids, which undergo differentiation and
remodels into streamlined spermatozoa with a species-specific head shape and acrosome and flagella [3]
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chromosomes condense, pairs, synapses and undergo genetic recombination. At the end of the

first meiosis, two tetraploid secondary spermatocytes are formed. They undergo a shorter meiosis

and produces two haploid round spermatids, as shown in fig 1.2. The third and last phase of sper-

matogenesis is called spermiogenesis or spermatid differentiation. There are 16 steps in mouse

spermiogenesis, where steps 1-7 is the round spermatid phase and 8-16 is the spermatid elonga-

tion phase. The elongated spermatids follow spermiation and leave the lumen of the seminiferous

tubule, as shown in fig 1.1. The spermatid differentiation consists of many complex events that

structurally and functionally change the cell [3, 4]. The formation of acrosome is one of the ear-

liest events and is called acrosome biogenesis. It is divided into different phases. The first phase

called the Golgi phase extends from steps 1-3. During the Golgi phase, the pro-acrosomal vesicles

are trafficked from trans-Golgi sacs and the endocytic pathway forming the acrosomal granule near

the nucleus. Studies have shown that the correct spatial orientation of the Golgi sacs is facilitated

by microtubules. This coincides with our knowledge of eukaryotic vesicle trafficking that it is me-

diated by microtubules for long-range movements and actin-based networks for short-range [5].

The next phase that extends in steps 4-7 is called the cap phase, where the acrosomal granule

grows and spreads over one-third of the nuclear membrane. Next is the acrosomal phase, where

the acrosome migrates to the ventral side of the nucleus, condenses and binds to the inner acroso-

mal membrane. The last phase that extends from steps 13-16 is called the maturation phase [6].

Here, the acrosomal granule spreads throughout the acrosomal membrane and the acrosome dif-

ferentiates to form the acrosome apex at the anterior, and cover the width of the nuclear surface

at the posterior. These four phases that involve in the formation of each pro-acrosomal vesicle,

transport, attaching to the nuclear region and expansion of acrosome, all depend on the F-actin

and microtubule-based networks and the proteins associated with them, and the failure in any of

these steps lead to globozoospermia [7, 8]. Another event that occurs during spermatogenesis is

the nuclear modeling. The round spermatids in steps 1-7 have a central spherical nucleus and

de-condensed chromatin. The shaping of the nucleus is done by the actin hoops of the Sertoli

cell and cytoskeletal structures called the acroplaxome and the manchette, both of which will be
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discussed in the next section. Flagellar formation starts simultaneously with acrosome formation.

The centrosome inherited during meiosis migrates to the caudal pole of the cell and one of its two

centrioles forms the axoneme structure at the ventral portion of the cell [9]. Mitochondria from the

cytoplasm forms the helix at the middle piece of the flagellum and a fibrous sheath forms at the

principal piece of the cell after the axoneme growth is completed. The proteins are moved to the

base of the sperm tail by intramanchette transport.

1.2 Cytoskeleton in spermatids

In eukaryotes, the cytoskeleton is composed of microtubules, intermediate filaments and micro-

filaments or actin filaments, all of which provide infrastructure for biological function and motility.

The filaments form a vast geometrical network by cross-linking and undergo deformation to estab-

lish cell connections and participate in cellular activities. Microtubules are made of α and β tubulin

heterodimers bound together to form clusters of straight and polar trusses. Various microtubule-

associated proteins like kinesin and dynein are present to ensure the timely performance of func-

tions such as cross-linking and cargo transport. Microfilaments are assembled by globular actin

forming a bifilar helix called F-actin or filamentous actin and along with their microfilament pro-

teins like myosin, impact cellular functions and multiple stages of spermatogenesis [2].

1.2.1 Acroplaxome

Kierszenbaum et al. [10] first observed that a cytoskeletal plate containing F-actin and keratin

anchors the developing acrosome to the nuclear envelope in rat spermatids. They designated the

plate as acroplaxome and observed that it consists of a marginal ring made of 10 nm thick inter-

mediate filaments that inserts into a dense plaque associated with the leading edge of the inner

acrosomal membrane. It contains a second plaque opposite to the intermediate filament-plaque

complex and is linked to the nuclear lamina [11, 12]. Linker of nucleoskeleton and cytoskeleton

(LINC) complexes bridge the nuclear lamina to the F-actin in the acroplaxome [8]. It was observed

in later experiments [11] that during the nuclear modelling, the acroplaxome fastens the caudal re-

5



Figure 1.3: Schematic representation of the processes during spermiogenesis that are involved in sperm
head shaping. The figure was taken from Teves and Rolden 2021 [4] and used under Creative Commons
Attribution CC by 4.0. The F-acting containing hoops are ectoplasmic specializations in the Sertoli cell and
generates external forces. The structure covers more than one-third of the spermatid head. The acroplaxome
modulates the forces generated by the F-acting containing hoops. The manchette encircles the remaining
two-thirds of the nuclear region and generates internal forces due to zipper-like movement. The molecular
composition of the nuclear membrane is restructured to allow the nuclear membrane to be flexible to the
external and internal forces.
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gion of the developing acrosome to the nuclear envelope. As discussed in the previous section,

during acrosome biogenesis the acroplaxome facilitates the adhesion of pro-acrosomal vesicles to

the nuclear membrane and their transverse spreading in the cap phase. Disruption in the produc-

tion, transport or adhesion of these pro-acrosomal vesicles is a leading cause of male infertility

like globozoospermia. It was also found by Kierszenbaum and collaborators [11] that myosin Va

is a component of the acroplaxome and hypothesized that it drives the expansion of the leading

edge of the acrosome and that during nuclear shaping, it facilitates in connecting the acrosome

to the F-actin network. It also avoids the DNA damage during acrosome reaction by restraining

forces [2]. Since its discovery, only few advances have been made to characterize the structure of

the acroplaxome and its molecular mechanisms and is hence deserving further investigation [4].

1.2.2 Manchette

The manchette comprises of microtubules and actin filaments, as can be observed in fig 1.3. It

assembles at the caudal site of acrosome-acroplaxome complex at spermatid step 8 after the acro-

some formation starts and spermatids enter the elongation phase. It disappears at step 14 as the

spermatid elongation is about to end and prior to the sperm tail mid-piece formation [13, 14]. The

structure comprises of a dense perinuclear ring consisting of keratin and tubulin that assembles

caudally to the proximity of the acroplaxomal marginal ring. Linear arrays of microtubules extend

from the perinuclear ring, in parallel to the long axis of the nucleus, and cover the lower side of

the nucleus [2, 5]. The short manchette microtubules that lie close to the nuclear membrane and

the long ones that extend radially are periodically attached to each other through linkers to form

a skirt-like structure [7]. The inner microtubules attach to the nuclear membrane through LINC

complexes. The manchette assembly begins after the acroplaxomal marginal ring starts to orga-

nize. A groove forms at the circumference of the overlapping marginal ring and perinuclear ring,

which also serves as the boundary for the F-actin grooves of Sertoli cells that holds the elongating

spermatid head. The manchette encircles the lower portion of this elongating head, from the end

of the acrosome to the region of the flagellum that is covered by the mitochondrial sheath [8]. The
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manchette performs three major tasks. Firstly, it expands by assembling diffused microtubules.

Secondly, the microtubule-associated proteins cooperate with myosin to perform intramanchette

transport (IMT). IMT provides tracks for the transport of proteins within the cytoplasm as well

as between the nucleus and the cytoplasm [6]. Thirdly, it exerts contractive forces to shape the

spermatid head, which will be discussed in the next subsection [2]. Intramanchette transport is

bidirectional since kinesin act as the plus end and dynein act as the minus end directed motors on

the manchette. The minus end motors serve for vesicle and protein movement down the manchette,

as required in acrosome biogenesis and axoneme formation, and plus end motors for the movement

up the manchette. Several experiments [10,15] confirmed β-actin and myosin-based vesicles in the

manchette, thus leading to the speculations that F-actin-based transport also contributes to IMT.

The cargos ferry for long distance (manchette to centrosome and axoneme) through microtubule-

based tracks and short distance (Golgi to the acrosome) through actin-based tracks [11]. The

manchette functions for flagellar formation by transporting the vesicles and proteins by IMT and

also perform nuclear-cytoplasmic trafficking by connecting to the nuclear membrane by LINC

complexes [2].

1.2.3 Role of cytoskeleton in nuclear remodeling and shaping of sperm head

The importance of sperm head shaping lies in the biological necessity of preserving the genome

until the end of fertilization. During the spermatid differentiation or elongation process, the round

spermatids will undergo a change in the nuclear shape and attain their species-specific head shape

[2]. Kierszenbaum et al. [13] found a mouse model for head shaping and recognized two elements

that the model relies on. The first one is the exogenous clutch which is the spatial arrangement of

F-actin containing parallel hoops of the Sertoli cells that embrace one-third of the sperm head at its

apex. The F-actin containing plaques can be mobilized in an up-and-down manner by the molecular

motors linked to the microtubules at the ectoplasmic specialization site, thus generating exogenous

forces that compress the nucleus. Fig 1.3 shows the F-actin hoop structures of the Sertoli cell. The

second element in the mouse model is an endogenous clutch formed by the acrosome-acroplaxome-
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manchette complex. The links between the nuclear membrane and the manchette microtubules are

crucial for the manchette movement and shaping of the sperm. As spermatids elongate, the links

at the apex disengage and those at the distal ends engage in a ratchet-like manner. The perinuclear

ring and the entire manchette structure move toward the tail region of the cell in a zipper-like

movement and constrict [14]. Thus as shown in fig 1.4, the manchette sculpts and tapers the head

of the spermatid as it migrates caudally down the nucleus while reducing its diameter progressively

as the spermatogenesis progresses. The acroplaxome is anchored to the nuclear envelope of the

elongating spermatid and the acrosome is bound to the acroplaxome. Both the perinuclear ring and

the marginal ring encircle two-thirds of the spermatid head at the caudal site, as can be seen in fig

1.3. The diameter of the marginal ring gradually reduces, mimicking the constrictive migration of

the manchette perinuclear ring as they descend along the nucleus toward the spermatid tail and thus

steers the elongation of the spermatid head and facilitates in the nuclear shaping. The acroplaxome

is stress-resistant and restrains the exogenous and endogenous forces acting on the spermatid head

from excessively deforming the nucleus [5].

Figure 1.4: Schematic representation of the manchette during spermiogenesis. The manchette develops at
the 8th step of spermatid and it constricts and sculpts the base of the nucleus while also progressing towards
the caudal portion of the cell. Adapted from [5]
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1.3 Super-resolution imaging

Fluorescence microscopy is a tool that is extensively used in molecular and cellular biological

research. It allows to image biological samples, their components and cellular processes non-

invasively. Techniques like immunofluorescence, in situ hybridization can be performed by the

use of a wide range of fluorescent probes that are available in different colors [16, 17]. However,

conventional fluorescent microscopy has a limited lateral resolution of approximately 200 nm and

an axial resolution of around 500 nm, which is larger than many intracellular structures. Hence

images of such structures obtained by a conventional fluorescent microscope are blurred or not

resolved. To overcome this issue, a series of methods were developed called ’super-resolution’

fluorescence microscopy. This section discusses the limit in fluorescent microscopy called the

diffraction limit, a super-resolution technique called Stochastic Optical Reconstruction Microscopy

(STORM) and the use of astigmatism in extending STORM from 2D to 3D.

1.3.1 Diffraction limit

In 1873, Ernst Abbe recognized that when the objective of the microscope converges light, the

rays do not converge into a sharp focus but has a finite width. The size of that width is proportional

to the wavelength of light and inversely proportional to the numerical aperture of the objective.

The resolution of the microscope is depended on this spot as its intensity profile is of the same

width of the spot. Hence the minimum width between two fluorophores such that they do not

produce overlapping images and be considered a single image, is the width of the point spread

function(PSF) [18]. This limit of resolution of far-field microscopic imaging is called Abbe’s limit,

which is given by d= λ/(2NA) where d is the minimum distance between the objects at that they

can be resolved, λ is the wavelength of light and NA the numerical aperture of the objective [19].

In the experiments conducted for this thesis, λ is 641 nm, NA is 1.49, thus the lateral resolution

limit according to the formula is 215 nm.

To overcome this diffraction limit some experiments used near field scanning microscopy and

achieved a resolution of 100 nm but the application to conduct imaging needs a scanning probe
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close to the sample [20]. Far field methods that exploit the physical properties of fluorescent

probes to determine positions of neighboring molecules in a diffraction limited region were devel-

oped in the recent years and were found to improve resolution to 20 nm [17, 18, 21]. These dis-

tinguished emissions of neighboring fluorescent molecules using spatially patterned illumination

like stimulated emission depletion microscopy (STED) and saturated structured illumination mi-

croscopy (SSIM) or performed single molecular imaging by stochastic activation of photoswitch-

able molecules like stochastic optical reconstruction microscopy (STORM), photoactivated local-

ization microscopy (PALM) and fluorescence photoactivation localization microscopy (FPALM).

Both the methods exploit the fluorescent molecules chemically or physically to maintain nearby

molecules in on or off states so that they can be individually resolved [18].

1.3.2 Stochastic Optical Reconstruction Microscopy

Figure 1.5: Principle of STORM. This image is taken from the PhD dissertation of Xinran Xu who is
a previous student in Krapf lab [22]. Only one fluorescent molecule is activated at a given time in the
diffration-limited region. The accumulation of these individual localization of molecules form the STORM
reconstructed image
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In STORM technique fluorescent molecules are stochastically activated individually from dark

state (ON) to emission state (OFF) and the process is repeated several times. Individual molecules

within a diffracted limited space can be precisely localized by this exploition of their photoswitch-

able nature. The image of a fluorescent molecule reflects the point spread function(PSF) of the

microscope and appears as a diffraction-broadened peak. The center of this peak gives the position

of the fluorophore. In biological samples, a single molecule can be localized by a precision of up

to 1 nm [16, 23,24]. This nano scale precision does not translate into image resolution. As long as

the fluorophores are separated by a distance greater than the PSF width, they can be resolved but

if they are positioned closer, their images overlap and the overall image will be a blur.

Hence, in STORM the emission from a region is controlled such that in a diffraction limited

region, at a point of time, only one fluorophore is activated [25]. This fluorophore goes into dark

state and another one in the same region gets activated and localized. This principle is illustrated in

fig 1.3. The activation light applied to the sample has to be sufficiently low to achieve a low density

of activated molecules such that only a sparse set of fluorophores are activated to emission state,

allowing each of them to be individually localized. This repeated cycle of activation-imaging-

deactivation leads to a super-resolved image reconstructed from several thousands of single fluo-

rescent molecule localizations [16–18, 21, 26]. Consequently, the image resolution is limited not

by diffraction but by the number of fluorescent molecules localized [25, 26].

STORM process requires the use of photo-switchable fluorophores for the proper labeling of

the target molecules, stochastic activation of the fluorophores we labeled with and collection of

large number of the fluorophores by the camera with nanoscale precision of localization of indi-

vidual fluorophores [27, 28].

1. Immunofluorescence: The labeling of target proteins with organic proteins or dyes is done

by immunofluorescence. The labelling density should be large so as to image sub-diffraction

limited intracellular structures and functions.The molecules that we label with should satisfy

a few conditions to generate a good STORM image. They should give out emission at a

particular range of wavelengths and should otherwise be in a non-emitting dark state, which
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by extension means that the contrast ratio between fluorescent and dark state should be high.

This parameter allows high label density in samples without much background fluorescence

[17]. In addition they should emit large number of photons. Furthermore, they should have

a low spontaneous emission rate to limit to avoid thermally induced activation [18]. Another

important parameter is that the rate of transition from the ON state to the OFF state (koff )

is larger than the rate of transition into the ON state (kon). Alexa Fluor 647 matches all

these criteria. They are very bright, detect about 6000 photons per activation cycle, have a

contrast ratio of 1000, and high duty cycles to ensure repeated localizations [17, 29]. In the

experiments discussed in this thesis we have used Alexa 647 dye.

The term photoswitchable or photoactivable is used only for the fluorescent molecules that

can be converted to two or more distinct states when illuminated by an external light source

[16]. Standard fluorophores like Alexa Fluor and ATTO belong to the rhodamine and oxazine

classes and have energetically stabilized triplet states, hence are photoswitchable [30]. In

the presence of potent donors like thiols and aromatic amines these dyes are photoreduced

from the triplet state forming stable radical anions [27, 31, 32]. (koff ) is controlled by the

concentration of thiols. Because of these reasons we add 2-mercaptoethanol which is a

thiol compound, to the imaging buffer that we add to the sample right before imaging. In

the presence of molecular oxygen, the rhodamine dyes survive for hundred of milliseconds

and they get trapped in radical ion state for several hours on the removal of oxygen. (kon)

depends on the concentration of oxygen [27]. Oxygen scavengers improve the reversibility

of photoswitching and reduces photobleaching [21, 33, 34]. Therefore we add an oxygen

scavenger- GLOX to the imaging buffer.

2. Image Acquisition: STORM imaging set-up consists of an illumination source, a light col-

lector and an image detector. The source of illumination in our experiment is a laser. To

ensure that most fluorescent molecules are in OFF state than in ON state at a given time,

the laser should be of high power. For the experiments discussed in this thesis, we used a

laser of an output power of 150 mW. High powered laser increases background fluorescence
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and that should be mitigated, for example, while imaging phalloidin-stained actin, sodium

borohydride is added in the immunostaining process to reduce autofluorescence. A total in-

ternal reflected microscope (TIRF) with an oil immersion objective of high aperture is used

as the light collector. Since TIRF mode limits the fluorophore excitation to a thin field of

100-200 nm and since in our experiment the target molecules lie above 200 nm from the

objective, the microscope is aligned close to TIRF but not at TIRF. An electron-multiplying

charge controlled device (EMCCD) camera with high quantum efficiency and low noise is

used for image detection. The pixel size is set as 2.3 times smaller than Abbe’s limit in order

to preserve the information of fluorophore position. Pixel size is in the range of 80 nm to 160

nm for visible light [21]. In our experiments, the optical system we use has a pixel size of

130 nm (camera has a pixel size of 13 nm and the 100x objective magnifies it by 100 times).

3. STORM Reconstruction: The collected data is processed by a series of steps. Firstly, a

smoothing filter is applied to each image to locate the pixels with intensity values, which

are the pixels with the highest number of photons detected in that PSF sized region. These

locations translate to probable fluorophore positions [35]. Secondly, a 2D gaussian win-

dow is fitted with the PSF model to localize fluorophores. The amplitude translates to the

number of photons, center in X and Y gives an estimate of position of fluorophore or lo-

calization [21, 36]. Mathematical computation models like least square fitting or maximum

likelihood estimation is performed to fit the gaussian to PSF model. During these steps, a

photon threshold is applied to ensure that multiple fluorophores in a diffraction limited space

are not localized at a time, thus avoiding overlapping PSFs. As STORM uses reversible pho-

toswitchable fluorophores, it is very likely that the same fluorophore has been individually

localized multiple times. So discarding duplicates does not adversely affect the structural

information. Post processing steps include duplicate removal, filtering, drift correction and

merging. Drift correction is a crucial step. Axial drift is corrected online with ASI MS

2000 device during image acquisition (refer 2.3.6 for details and Appendix G- Finding and

imaging spermatid for procedure) while lateral shift can be corrected using cross-correlation
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methods in the post-processing step. Merging is done at the end of post-processing to com-

bine all the single molecular localizations to a super-resolved image.

1.3.3 Astigmatism method

The experiments conducted in this thesis aim to 3D localize cytoskeleton in spermatids. To

expand the STORM technique to 3D capability, the lateral as well as axial positions of the fluo-

rophores are required [17]. Methods using double helical PSFs, interferometers and defocusing by

dual or multi-focal plane or astigmatism, are the most popular for this purpose [37, 38]. Defocus-

ing methods are easier to implement than the others. In astigmatism method, a cylindrical lens is

introduced to the optical pathway in x and y directions forming two different focal planes that re-

shape PSF with different ellipticity [22]. This is because light propagating in perpendicular planes

have different focal points. A single molecule appears elliptical and hence by its ellipticity we can

determine axial position and from its center the lateral position can be found [16]. By fitting the

image with a 2D elliptical Gaussian function, z coordinate of the fluorophore can be determined.

Although the method is easier to implement and has about 50 - 60 nm axial resolution, astigmatism

approach does not correct optical aberrations within the system and also induces aberrations with

the addition of the cylindrical lens causing deformations in PSF. To overcome these issues, Mi-

cAO 3DSR adaptive optics device was introduced to our optical system. It contains a deformable

mirror that corrects the aberrations introduced in the system by the optical elements and biological

sample [39]. The mirror adds the perfect amount of astigmatism to the system, allowing precise

3D localization of fluorophores.
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Chapter 2

3D Localization of α tubulin in spermatids

2.1 Introduction

The eukaryotic cytoskeleton comprises of three filament systems- microtubules, actin filaments

and intermediate filaments. Microtubules are larger than actin filaments and are hollow tubes of

about 25 nm in diameter. They are made of alpha and beta tubulin heterodimers which polymerize

into linear protofilaments [7, 40]. The head-to-tail arrangement of α or β heterodimers results in

structural polarization, with α tubulin located at the minus end and β tubulin at the plus end. The

plus end is characterized by state of rapid growth and the minus end has slow growth because it

is the end that anchors the microtubule. Microtubules undergo polymerization and depolymeriza-

tion, thus rapidly alternating between shrinkage and growth. This dynamic instability is a unique

feature of microtubules. [41]. In certain cells, microtubules radiate from the centrosome and form

an organized network but haploid male germ cells have non-centrosomal microtubule arrays that

perform various cell functions such as cytoplasmic transport of proteins and vesicles, chromosome

alignment during meiosis and mitosis, and beating of flagella. The trafficking of proteins to specific

cellular regions plays a crucial role in the proper sperm development. Two such cellular regions are

the region between the endoplasmic reticulum, the Golgi apparatus and the acrosome-acroplaxome

complex, and the manchette. As discussed in section 1.1 , during acrosome biogenesis, the pro-

acrosomal vesicles are trafficked via microtubule and actin tracks. As discussed in section 1.2.2,

the manchette is formed at step 8 during spermatid elongation and is made of microtubules and

actin filaments. it plays a vital role in nuclear modelling and cytoplasmic transport as well as

transport between the nucleus and cytoplasm via IMT.

The experiment discussed in this chapter uses 3D STORM technique to visualize α tubulin in

the cytoskeleton of spermatids. Based on experiments conducted by our collaborator Dr Maria

E. Teves and her research team at Virginia Commonwealth University, we know that α tubulin is
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localized in the manchette. Since the manchette assembles at step 8 and completely disassemble

after step 14, we focus on steps 10-14. We find that manchette is rich in α tubulin and the structure

radiates from the base of the nuclear region and moves caudally as spermatid elongation progresses.

Also, the experiments confirmed that machette is assembled to form its rigid cytoskeletal network

in step 10 and disassembles into constituent structures after step 14.

2.2 Materials and methods

2.2.1 Sample collection

Detailed protocol for sample collection is in Appendix C - Collecting and fixing spermatid cells

from mice.

Mice that are at least 5 weeks old were purchased from Charles River Laboratories (Wilming-

ton,MA). Animals were euthanized according to the guidelines of Institutional Animal Care and

Use Committee (IACUC) of Colorado State University. Two testes were collected and stored at

4◦C in Dulbecco’s Modified Eagle Medium (DMEM) which has vitamins, amino acids and glucose

to maintain cells in its environment. The testes were dissected and its contents were collected in

an isolation buffer made of DMEM, and the digestion enzymes- collagenase and DNAse. DNAse

reduces clumping of cells. The sample is incubated at 32◦C and is mechanically digested to break

the tissue. This process is done with care so that the cells do not break. The flagella and acrosome

are not fully formed structures in many spermatid stages and they may be broken or displaced from

the cells. The sample then undergoes multiple centrifugation processes to separate the spermatid

cells from other cells and debris in the sample, and gets suspended in Phosphate-Buffered Saline

(PBS) before sample fixation.

2.2.2 Fixing samples

Detailed protocol for sample fixation is in Appendix C - Collecting and fixing spermatid cells

from mice. Freshly prepared fixative solution made of Sucrose and Paraformaldehyde in PBS

is added to the cells. Paraformaldehyde is a fixative and is added to preserve the cellular struc-
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ture without changes in protein structure [42]. It is an important step before permeabilizing and

immunostaining the cells as cells that are not fixed will lyse and diffuse away before antibody incu-

bation step. The sample is then centrifuged and suspended in PBS. The sample density is checked

by adding 8 µl of sample to a coverslip and mounting the sample on a microscope. If the cells are

too crowded, dilute the remaining sample by adding 1 to 2 µl of PBS. Check the sample again and

correct the density so that the sample has enough density but the cells are not clumped. Once it

reaches the desired density, transfer the cells to Poly-L-lysine coated coverslips.

2.2.3 Immunostaining samples by indirect immunofluorescence

The protocol for immunostaining is explained in detail in Appendix D- Labelling the cells.

Imunofluorescence can be achieved by two methods- direct and indirect. In direct immunoflu-

orescence, fluorescent label is conjugated directly to an antibody, and this identifies and binds to

the target molecule. This method is faster and has less issues related to non-specific binding that

causes background signal but, each target requires specific antibodies and hence it is experiment

specific, reducing the flexibility of the experiment design. Also, fluorescence-coupled primary an-

tibodies are expensive [43]. Indirect immunofluorescence uses two antibodies- a primary that is

unconjugated and recognize and attach to the target, and a secondary antibody that is tagged with

fluorescent dye and recognizes and binds to the primary antibody [44, 45]. This method is slightly

more complex than the direct method but more flexible for the experiments as the secondary anti-

body conjugates can be easily available in the market. Each protocol needs to be tweaked according

to the cell type and antibody.

Immunostaining process requires the cell membrane to be more porous than usual so that larger

molecules like antibodies and fluorescent dyes can pass into the cytoplasm and reach the targeted

intracellular structures [46]. This can be achieved by removing lipids from the cell membrane by

use of organic solvents or detergents. In our method, we use Triton X-100 which is a detergent.

After a couple of PBS washes, a blocking buffer made of goat serum, Bovine Serum Albumin

and Triton is added to the sample [47]. Goat serum contains antibodies that bind to the non-
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specific sites of the target molecule. Blocking is an important step in reducing the background

interference and improving signal-to-noise ratio. After incubating the sample with blocking buffer,

primary antibody is added [48]. The samples are incubated for 12 hours. The samples are washed

with PBS three times to remove any cells that are not bound to the coverslip and also wash any

primary antibody that is unbounded. The secondary antibody solution is added to the coverslip

and incubated for an hour and then washed with PBS. Before imaging, an imaging buffer made

of 2-mercaptoethanol and GLOX is added. 2-mercaptoethanol is a thiol compound that induces

stochastic blinking of fluorophores, which is the fundamental idea of STORM. GLOX removes

oxygen from the sample, thus preventing photobleaching.

2.3 Instrumentation and software

2.3.1 Aligning TIRF microscope

For imaging we use a Total Internal Reflection Fluorescence (TIRF) microscope. The target

molecules are located more than 200 nm from the coverglass surface and hence instead of TIRF,

the imaging set-up is only set to close to TIRF [28]. For that the system is aligned to TIRF and

adjusted. The laser and microscope alignment protocol is detailed in Appendix E- Protocol for

aligning a TIRF microscope. The alignment has to be done before every imaging to ensure good

quality images.

2.3.2 3D STORM imaging set-up

STORM imaging set-up consists of a LASER for illumination, objective lens for light collec-

tion and camera for image detection.

1. Laser:

STORM requires a high power laser so that most of the fluorophores are in the OFF state

and only few are ON. In Krapf lab we use a 641 nm laser ( CW Diode laser DL640-150-O,

CrystaLaser, Reno, NV). A violet laser- 405 nm was used to photo-switch the photo-bleached

fluorophores.
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2. Objective lens:

STORM technique employs precise localization of individual fluorophores from detecting

photons at every activation, hence identifying their position coordinates. The precision of

this localization is proportional to the resolution of the objective and hence is inversely pro-

portional to the numerical aperture of its objective [28]. Also, higher the numerical aperture

(NA), higher the number of photons detected. The objective lens used in the image set-up

is an Olympus PlanApo 100xNA 1.49 objective. It is an oil immersion objective. Oil im-

mersion objectives reduces light loss from refraction by replacing air gap between the glass

slide and objective lens with oil [49–51]. The oil becomes part of the objective system and

improves the resolution and hence the NA is same as if the objective diameter was increased.

3. Camera:

Super-resolution techniques require cameras with high quantum efficiency and low noise,

and have deep cooling mechanism. We used Andor iXon DU-888, water cooled , back

illuminated EMCCD camera. The cooling helps to reduce the dark current in the device and

hence the system is maintained at -70 ◦C. Since the camera is back illuminated high number

of photons are preserved, thus increasing quantum efficiency. As all the pixels in the camera

share a gain register as well as an analog to digital converter and has on-chip multiplication

technology, an EMCCD camera has low fixed pattern noise and low read noise. The camera

captures images at the rate of 50 frames/second.

2.3.3 Calibrating the MicAO

STORM technique uses the principle of stochastically activating individual fluorophores that

are photo-activable and spatially resolves localization of these individual fluorophores with high

precision [52]. The process is repeated over and over to capture most fluorophores. As experi-

ments, such as discussed in Yildiz et al., have shown that single fluorophores can be detected with

a signal to noise ratio about 100, thus limiting the localization precision at 1nm in lateral dimen-

sions [23,28,53]. The centroid of an image of a fluorophore gives the information about its lateral
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position and shape of that image gives its axial position. Since the PSF is symmetrical along the z

axis, regular STORM techniques has poor axial resolution. To combat this issue many experiments

have employed the astigmatism method where a weak cylindrical lens is introduced in the image

pathway, thus creating a focal plane in x and one in y direction. Because of these slightly different

focus planes, the point spread function (PSF) appears to be round when fluorophore is in focus

(point of equal distance from x and y planes or average focal plane), ellipsoidal in y with its long

axis in x when it is above the average focal plane and ellipsoidal in x when it is below the average

focal plane [24]. To obtain the centroid with precision in x and y planes, the image is approximated

by a 2D Gaussian function. From this, the peak widths and the coordinates of the peak and hence

the z position can be obtained. Although this method has more accuracy than regular STORM

technique, adding a weak cylindrical lens introduces optical aberrations to the system, reducing

the number of photons collected and the shape of PSF [39,54]. In addition to this, the components

of microscope and the biological sample themselves cause optical aberrations. The adaptive optic

device- MicAO 3D-SR developed by Imagine Optic consists of wavefront sensor and deformable

mirror that precisely detects and corrects these aberrations [39]. The device has the 52 actuator

deformable mirror with the capability of inducing small amounts of 2D astigmatism in PSF [54].

During the first installation, an initial optimization was conducted for the microscope. The aber-

rations were measured by wavefront sensors and corrected using the deformable mirror and by

using 3N algorithm. The mirror shape was stored in the computer as closed loop Casao.has in

the lab computer. As explained in the Appendix F- 3D STORM Calibration Protocol, this mirror

shape serves as the reference for obtaining PSF. Since it was found that an astigmatism of 60 nm

gave the best PSF for the system, we set the astigmatism settings accordingly, as shown in figure

F.2 in Appendix F. This method allows 3D reconstruction of images of individual fluorophores by

accurate detection of single molecules over 1 µm axial range or thickness.
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2.3.4 Image acquisition

The protocol for image acquisition of spermatids is detailed in Appendix G- Finding and imag-

ing spermatid. The PSF used is the final PSF saved after calibrating the MicAO.

2.3.5 Obtaining look-up table

The sequence of super-resolution images obtained consists of 50 thousand frames. To process

such large data with sub-diffraction precision, we use ThunderSTORM which is an open-source,

interactive plug in for ImageJ that has a wide collection of processing and post-processing methods

[55]. The calibration tool of the software is used to obtain calibration curves from the z stack of

images obtained from 0.1 µm Tetraspeck microspheres, according to Appendix F- 3D STORM

Calibration Protocol. These images range from a z height of 1 µm to -1 µm with 10 nm thickness.

As mentioned in section 1.3.3, the obtained PSF is fitted by 2D Gaussian by which the peak widths

and the coordinates of the peak are obtained. The spread of the Gaussian curve in x and y helps in

determining the z position of the fluorophore. In ThunderSTORM, the image is filtered by wavelet

filter and fluorophores are localized by determining the local maxima. The software uniquely

allows setting a specific threshold for detecting molecules and previewing the resulting movie with

the molecules detected according to the settings. The threshold is fixed based on the best estimation

of molecules in the movies.

As the calibration curves that "are symmetric along z=0 and with noise levels of the the same

order above and below the focus" gives the most precise axial localization, we use the configuration

file from the calibration movie that produced the best sigma curve, for the 3D STORM reconstruc-

tion of the spermatid images [39]. Refer Appendix H for the protocol to obtain the configuration

file.

22



2.3.6 3D STORM Reconstruction of images

The calibration file is obtained from the calibration tool of ThunderSTORM, according to Ap-

pendix H. The software allows selecting multiple parameters to detect single fluorophores with

Figure 2.1: Calibration curve generated for a group of 0.1 µm Tetraspeck microspheres. The z stack is 2
µm with a step size of 10 nm

accuracy. To remove noise and improve the localization of individual fluorophores, wavelet

filter (B-spline) is used. This is particularly useful when the background is not estimated. The next

step is approximate localization of molecules which is done by recognizing the local maxima of

the pixel as its center. This stage rejects all molecules that occur in distance less than PSF diameter,

to avoid overlapping molecules and thus save computation time [28]. The sub-pixel localization

of molecules is done by approximating the PSF model by an elliptical gaussian function. The raw
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data is fitted to the PSF model by least square method. This method is robust to the distortions in

PSF caused by optical aberrations, and is preferred over other mathematical optimization methods

in cases where the exact information about the camera, PSF and noise model is not known. The

visualization of data is set as normalized gaussian. Once the processing is done, post-processing

routines are performed. ThunderSTORM allows removing duplicates obtained in the analysis.

After that step, we filter out molecules outside 500 nm z height on either side of the focus because

our calibration system has a localization precision over a z range of 1 µm [55]. The next step

is drift correction. This is essential to avoid blurs in reconstructed images as a drift of even 10

nm distorts images [56]. This is corrected in some experiments by use of fiduciary markers, but

since we do not wish to add new markers as it may interfere the imaging structures, and also the

imaging parameters need to be changed to adapt to these markers, we correct lateral drift by cross-

correlation methods [28]. The axial shift is corrected in our experiments by ASI- MS2000 which

compensates drifts due to factors like thermal expansion and mechanical vibrations, by relying

on the refractive index mismatch at the interface between coverglass and imaging medium. This

autofocus system detects the smallest drift between the objective lens and coverslip of the sample,

provides feed back to the focus controllers of the device and eliminates focus drift, thus enabling

the sample to remain accurately in focus while being imaged for several hours. The focus accuracy

is 5% of the objective depth of focus [57, 58]. Applying density filter removes isolated or poorly

localized molecules. Merging of molecules is done next. We can specify the number of frames

that the molecule should be repeatedly present to be considered a single molecule and the distance

along x and y within which molecules should be merged. Appendix I contains the detailed step by

step instruction for 3D STORM reconstruction.

2.4 Results

The 3D STORM images obtained showed that α tubulin is localized in the manchette of the

elongating spermatids. Fig 2.2 (a) shows the bright field image of a step 10 spermatid. The entire

cell could not be captured for 3D STORM reconstruction as the imaging system is limited at region
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(a) (b) (c)

Figure 2.2: α tubulin structure in a mouse spermatid at step 10 (a) Bright field image of a step 10 spermatid
with background subtracted. The height of the cell is longer than 100 pixels but the imaging set up limits the
ROI height to 100 pixels to reduce the time taken to capture 50000 frames. The region of the cell captured
by STORM imaging is marked with the black rectangle. (b) 3D STORM reconstructed image of α tubulin in
cell shown in image a with the z-position information color coded. The reconstruction is colored according
to the localization height as indicated in the color map. (c) Overlay of the bright field image a with the
reconstructed image b. Scale bar is 2 µm

Figure 2.3: Confocal images of step 10 spermatid. This image was obtained by Virali Bhagat [59] of Dr
Marie E Teves’ research team at Virginia Commonwealth University. ARL13B (red) is localized in the
acrosome and the manchette, acetylated tubulin is found in the manchette, DAPI is found in the nucleus
(blue). The differential interference contrast (DIC) image shows the step 10 spermatid which was stained
with ARL13B, acetylated tubulin and DAPI

of interest(ROI) height of 100 pixels. The ROI captured is marked with a rectangular black

box. It can be seen from the overlay image fig 2.2(c) that the manchette microtubules start at the

base of the nucleus and is extended towards the base of the cell in an almost diagonal fashion

as seen in the acetylated tubulin confocal image in fig 2.3 obtained by Virali Bhagat at Virginia

Commonwealth University. Moreover, the overlay of STORM reconstruction on the bright field

image, fig 2.2(c) shows the cytoplasm and the axoneme is almost completely devoid of α tubulin.
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The color coding shows the height of the localization of fluorophore in the spermatid cell, with red

marking the z height at one end and blue at the other end of the cell. Unlike in the 2D confocal

image, 3D STORM image shows that the localizations of α tubulin are points of 80 to 100 nm

diameter and are connected in a mesh-like manner and from the color coding, it can be seen the

manchette is present as mesh-like structures at the different depth of the cell and is present over

half the length of the cell.

(a) (b) (c)

Figure 2.4: α tubulin structure in a mouse spermatid at step 11 (a) Bright field image of a spermatid of step
11 with background subtracted (b) 3D STORM reconstructed image of α tubulin in cell shown in image
a with the z-position information color coded. The reconstruction is colored according to the localization
height as indicated in the color map. (c) Overlay of the bright field image a with the reconstructed image b.
Scale bar is 2 µm

Figure 2.5: Confocal images of step 11 spermatid. This image was obtained by Virali Bhagat [59] of
Dr Marie E Teves’ research team at Virginia Commonwealth University. AZI1 (red) is localized in the
acrosome, the manchette and centrosome, acetylated tubulin is found in the manchette, DAPI is found in the
nucleus (blue). The differential interference contrast (DIC) image shows the step 11 spermatid which was
stained with AZI1, acetylated tubulin and DAPI
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Fig 2.4 (a) shows a step 11 spermatid. Fig 2.4(b) shows points of localizations of about 80 to

90 nm diameter with hints of meshes of α tubulin but there are not enough localization points. The

larger points of specific localizations are about 310 to 460 nm in diameter. Again, the manchette

are observed at different z positions. It can be observed that from fig 2.4 (c) that as seen in the

acetylated tubulin image in fig 2.5, the manchette has moved further caudally down the cell.

The 3D reconstruction of step 12 spematid in fig 2.6 (b) shows an elaborate mesh network in

the region that α tubulin is distributed. Fig 2.6 (d) is an enlarged image of the marked rectangular

portion of the 3D reconstruction illustrating how extensive the mesh structure is. From our under-

standing of the observations in the 2D confocal images in fig 2.7, other research experiments [8,14],

and literature survey [4, 13, 60], we know that the structure where the α tubulin localizations are

interconnected is the manchette. Fig 2.6 (b) also shows the cell boundary clearly and it can be

observed that manchette is present throughout the depth of the spermatid. The STORM image

overlayed on the bright field, fig 2.6 (c) shows a further descent of the manchette. It can also be

observed that cytoplasm is getting eliminated as spermatid differentiation progresses. In step 14

spermatid seen in fig 2.8 (b), α tubulin localizations in the spermatid are interconnected at various

depths of the cell. Mesh-like structures can be observed, especially towards the caudal region of

the cell, as can be seen in the zoomed image in fig 2.8 (d). In fig 2.8 (c), it can be observed that the

manchette has extended from the acrosome to the base of the cell. The head of the spermatid has

now be shaped and has begun to achieve the hook shape as is expected in a mouse spermatid. It can

be observed from fig 2.8(c) that most of the cytoplasm has been drained from the spermatid. The

flagella can be seen to the right of fig 2.8(c). From 2.10 (b), it can be seen that α tubulin is only

present as points of localizations and not as defined structures. The manchette has disassembled to

its constituents in step 15. This observation conforms our knowledge that the manchette disappears

after step 14.
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(a) (b) (c)

(d)

Figure 2.6: α tubulin structure in the captured section of a mouse spermatid at step 12 (a) Bright field
image of a step 11 spermatid with background subtracted. The height of the cell is longer than 100 pixels
but the imaging set up limits the ROI height to 100 pixels to reduce the time taken to capture 50000 frames.
The region of the cell captured by STORM imaging is marked with the black rectangle. (b) 3D STORM
reconstructed image of α tubulin in cell shown in image a with the z-position information color coded. The
reconstruction is colored according to the localization height as indicated in the color map. (c) Overlay of
the bright field image a with the reconstructed image b. (d) Enlarged picture of the area surrounded by the
yellow rectangle in the 3D reconstruction. Scale bar is 2 µm

Figure 2.7: Confocal images of step 12 spermatid.This image was obtained by Virali Bhagat [59] of Dr
Marie E Teves’ research team at Virginia Commonwealth University. LRGUK (red) is localized in the
acrosome vesicles and the manchette, acetylated tubulin is found in the manchette, DAPI is found in the
nucleus (blue). The differential interference contrast (DIC) image shows the step 12 spermatid which was
stained with LRGUK, acetylated tubulin and DAPI
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(a) (b) (c)

(d)

Figure 2.8: α tubulin structure in a mouse spermatid at step 14 (a) Bright field image of a step 14 sper-
matid with background subtracted. The flagella is visible on the right side of the image (b) 3D STORM
reconstructed image of α tubulin in cell shown in image a with the z-position information color coded. The
reconstruction is colored according to the localization height as indicated in the color map. (c) Overlay of
the bright field image a with the reconstructed image b. d) Enlarged picture of the area surrounded by the
yellow rectangle in the 3D reconstruction. Scale bar is 2 µm

Figure 2.9: Confocal images of step 14 spermatid.This image was obtained by Virali Bhagat [59] of
Dr Marie E Teves’ research team at Virginia Commonwealth University. SUN3 (red) is localized in the
manchette, acetylated tubulin is found in the manchette, DAPI is found in the nucleus (blue). The differen-
tial interference contrast (DIC) image shows the step 14 spermatid which was stained with SUN3, acetylated
tubulin and DAPI
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(a) (b) (c)

Figure 2.10: α tubulin structure in a mouse spermatid at step 15 (a) Bright field image of a step 15 spermatid
with background subtracted. The flagella has been detached possibly during the mechanical agitation of the
sample during preparation (b) 3D STORM reconstructed image of α tubulin in cell shown in image a with
the z-position information color coded. The reconstruction is colored according to the localization height as
indicated in the color map. (c) Overlay of the bright field image a with the reconstructed image b. Scale bar
is 2 µm
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Chapter 3

3D Localization of phalloidin stained actin in

spermatids

3.1 Introduction

Actin was found to be encoded in ancestral genes from 3 billion years ago and is one of the most

abundant proteins in the world. Actin filaments or F-actin, also known as microfilaments, provide

mechanical support, move proteins, vesicles and intracellular materials and drive cell movements

[61]. Animals have actin filaments, microtubules and intermediate filaments as their cytoskeletal

polymers. Genes for actin are highly conserved in all eukaryotic cells and have many genes for

the molecular motor myosin which on hydrolysing Adenosine Triphosphate (ATP) generate forces

on microfilaments and assist in many functions such as cellular transport and cytokinesis [62, 63].

Actin and myosin were discovered in muscle cells in the 1940s and were found to be present in

other cells in the 1960s. Globular actin or G-actin is the basic unit of actin filaments. When

initiated by actin nucleators or nucleation complexes, G-actin monomers binds to ATP forming

stable di- or trimers and by the addition of more monomers form a long stable double helical chain

of F-actin [7, 60]. As actin monomers are oriented asymmetrically, actin filaments are polar with

their two ends, called barbed end and pointed end, being biochemically and structurally different

from each other [64]. The barbed end is the fast growing end due to ATP-dependent elongation

and is called the plus end, and the pointed end shortened by dissociation and is called the minus

end. This elongation at one end and shortening at the other is called actin filament treadmilling

and generate forces for many cellular processes along with the forces generated by myosin [65].

Myosin molecules travel towards either of the two end of actin filaments and transport various

cargo in the cell.
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Actin filaments are concentrated in spermatogonic cells and Seroli cells. Sertoli cells have

apical ectoplasmic specializations composed of actin filament bundles sandwiched between Sertoli

cell plasma membrane and cistern of endoplasmic reticulum between Sertoli cell and the head of

elongating spermatid [66, 67]. These F-actin containing hoops exert external forces that shapes

the nucleus and hence the head of the elongating spermatid, as discussed in section 1.2.3. F-actin

is also found in the acroplaxome of the cell, which as discussed in section 1.2.1, is an actin rich

cytoskeletal plate connecting acrosome and spermatid nuclear membrane. It is also found in the

manchette which is a temporary structure that assembles at step 8, during spermatid elongation,

and disassemble at step 14. The manchette is located at the caudal region of the acrosome and as

discussed in section 1.2.2 plays a major role in trafficking of cargo by facilitating IMT, thus critical

for acrosome and axoneme formation, and also tapers and shapes the nuclear head.

To image actin many investigators have used phalloidin conjugated fluorescent molecules.

Phalloidin belongs to a class of toxins found in death cap mushroom called phallotoxins. It binds

and stabilizes F-actin and prevents the depolymerization of actin fibers [68]. Unlike antibodies,

phalloidin does not bind to G-actin monomers and is permeable to aldehyde fixed cells [69]. This

selective binding to F-actin makes phalloidin containing fluorescent tags an excellent tool in visu-

alizing F-actin in microscopy methods.

In this chapter, we will discuss an experiment to image F- actin in the cytoskeleton of sper-

matids of step 10 to 14 by 3D STORM technique. As mentioned in chapter 2, we chose these steps

to observe a fully developed manchette and acroplaxome. To image F-actin, phalloidin conjugated

with Alexa Fluor 647 is used in immunostaining process. We confirmed in 3D that actin is lo-

calized in acroplaxome of spermatids and is also present in the manchette. In addition to this, as

observed in the experiment in chapter 2, the manchette is found to descend to the caudal region of

the spermatid head as the spermatid differentiation progresses. Moreover, manchette is found to

be located at the base of the cell at step 14 and is found to have disassembled in the later steps.

32



3.2 Materials and methods

3.2.1 Sample collection

This section is explained section 1.2.1- Sample collection. Detailed protocol for sample col-

lection and preparation is in Appendix C - Collecting and fixing spermatid cells from mice.

3.2.2 Immunostaining samples by indirect immunofluorescence

As explained in section 1.2.2- Fixing samples, fixing is a crucial step before immunostaining

with molecules. The sample is fixed with a solution containing gluteraldehyde and Triton X-100.

Triton is a detergent that removes lipids from the cell membrane to make it more porous for larger

molecules. Freshly prepared sodium borohydride is added to reduce autofluorescence because of

the aldehyde added to the sample [70]. The washes are done with cytoskeleton buffer to preserve

the intracellular structure of the cells in the sample. This procedure uses direct immunofluores-

cence. Phalloidin is conjugated with Alexa 647 fluorescent dye [68]. It is used as it binds to

filamentous actin (F-actin), thus in STORM imaging it helps in localizing actin filaments. The

ideal time of incubation was found to be 10 hours. The samples are stored in PBS until imaged.

As in section 1.2.3 the imaging buffer containing thiol (2-mercaptoethanol) and oxygen scavenger

(GLOX) is added just before imaging. The protocol for immunostaining is explained in detail in

Appendix D- Labelling the cells.

3.3 Instrumentation and software

This section is explained in section 1.3- Instrumentation and software. The protocol is the same

for imaging actin as both experiments use STORM imaging and ThunderSTORM for reconstruct-

ing the images collected.

3.4 Results

Fig 3.1 is a 2D confocal image of F-actin obtained by Dr. Maria E. Teves and her research team

and shows that F-actin is present in the acroplaxome but as it is not as sensitive as 3D STORM
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images, the structures in manchette are not visible. The 3D STORM images of phalloidin stained

actin shows that F-actin is present in the acroplaxome and the manchette of the elongating sper-

matids. The blue and red red spots in fig 3.2 (c) are of about 50 to 70 nm in diameter and shows

the localizations of F-actin in the acroplaxome in a step 10 spermatid and confirms in 3D that the

acroplaxome is rich in F-actin. It can be observed that it is at the base of the nucleus and as per

the color coding, it is seen to extend in depth from one end of the cell to atleast one-third of the

cell. The exact depth is unknown as our system is limited to imaging 1 µm depth. The length

of the acroplaxome in the image is 8.71 µm. The manchette is the region in green and is seen to

extend from the acroplaxome region to the base of the cell. The larger ellipse-like yellow points

of about 0.38 and 0.59 µm diameters are structures that have more specialized localizations. This

proves that the manchette is also rich in F-actin. The region between the acroplaxome and the

manchette is devoid of F-actin is the cytoplasm. Fig 3.3 (a) shows a step 11 spermatid. F-actin is

more broadly distributed in the spermatid with larger localizations of about 0.5 to 1 µm size, as

seen in fig 3.3 (b). It can be observed according to the color coding that manchette is present at the

middle of the cell. The acroplaxome is rich in F-actin and hence is observed in yellow and green

at the head portion of the cell as a uniformly distributed structure of about 8 µm in length.

Figure 3.1: 2D confocal image of F-actin in step 14 spermatid. The region marked in the red shows the
F-actin. It can be observed that only the acroplaxome shows F-actin distribution
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(a) (b) (c)

Figure 3.2: Actin structure in mouse spermatid at step 10 (a) Bright field image of a step 10 spermatid
with background subtracted. (b) 3D STORM reconstructed image F-actin labeled with phalloidin-Alexa
Fluor647 in spermatid cell shown in image a with the z-position information color coded.The reconstruction
is colored according to the localization height as indicated in the color map. (c) Overlay of the bright field
image a with the reconstructed image b. Scale bar is 2 µm

(a) (b) (c)

Figure 3.3: Actin structure in mouse spermatid at step 11 (a) Bright field image of a step 11 spermatid
with background subtracted. (b) 3D STORM reconstructed image F-actin labeled with phalloidin-Alexa
Fluor647 in spermatid cell shown in image a with the z-position information color coded. The reconstruction
is colored according to the localization height as indicated in the color map. (c) Overlay of the bright field
image a with the reconstructed image b. Scale bar is 2 µm

(a) (b) (c)

Figure 3.4: Actin structure in mouse spermatid at step 12 (a) Bright field image of a step 12 spermatid
with background subtracted. (b) 3D STORM reconstructed image F-actin labeled with phalloidin-Alexa
Fluor647 in spermatid cell shown in image a with the z-position information color coded.The reconstruction
is colored according to the localization height as indicated in the color map. (c) Overlay of the bright field
image a with the reconstructed image b. Scale bar is 2 µm
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Fig 3.4 (a) shows a step 12 spermatid. On comparing images 3.4 (b) and 3.4 (c), it can be

observed that the acroplaxome is present at the base of the nucleus. The uniform yellow and red

structure of length 6 µm shows that F-actin is broadly distributed within the acroplaxome. Specific

localizations of F-actin is observed in the manchette as yellow and red points of size 0.6 to 0.9 µm.

In image 3.4 (b), the green localization close to the scale bar and the red point at the right of the

image are fluorophores present on the coverslip, outside the cell, as can be observed in fig 3.4 (c).

Fig 3.5 shows a step 13 spermatid. The structure to the right of the image in fig 3.4 (b) and (c) is

the acrosome. It has detached partially from the cell during the mechanical agitation of the sample

during preparation. From the color coding of the z positions, the machette is seen to be present at

one end of the cell and gradually extending to at least one-third of the cell at the caudal region.

On comparing image 3.4(c) and 3.5 (c), the manchette is observed to be reducing in diameter and

is progressing down the cell and that the nucleus is getting shaped by the forces exerted by the

acroplaxome and the manchette. It can be seen that the axoneme shows no F-actin. From fig 3.5

(c), the spermatid is seen to be almost devoid of cytoplasm, as is expected in the end stages of

spermatid elongation or differentiation.

(a) (b) (c)

Figure 3.5: Actin structure in mouse spermatid at step 13 (a) Bright field image of a step 13 spermatid with
background subtracted. It can be observed that the acrosome has partially detached from the anterior region
of the cell (b) 3D STORM reconstructed image F-actin labeled with phalloidin-Alexa Fluor647 in spermatid
cell shown in image a with the z-position information color coded. The reconstruction is colored according
to the localization height as indicated in the color map. (c) Overlay of the bright field image a with the
reconstructed image b. Scale bar is 2 µm
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Chapter 4

Conclusion and Future work

In this thesis STORM was used as a tool to 3D localize the cytoskeleton in mouse spermatids.

For this purpose, two set of experiments were conducted. The first one was to image αtubulin in

spermatids. We observed that the manchette is an integral structure in elongating spermatids of

steps 10 to 14 and that it disassemble at step 14. The αtubulin localizations in these spermatids

were found to be interconnected in a mesh-like manner. It was observed that the manchette moves

down the cell, reducing in diameter as the spermatids differentiate conforming that it is responsible

for shaping the base of the nucleus and hence the spermatid head. The second set of experiments

were conducted to image F-actin in spermatids. In order to do that, phalloidin stained Alexa Fluor

647 was used as phalloidin binds to F-actin and not G-actin and is excellent to use in aldehyde

fixed cells. The results showed that the acroplaxome is rich in F-actin. 2D confocal images failed

to image F-actin in manchette due to its poor sensitivity but our experiments showed that F-actin is

present in the manchette. Moreover, the manchette and the acroplaxome were the only structures

that showed an abundance of F-actin.

To the best of our knowledge, the cytoskeleton of spermatids has never previously been imaged

with a super-resolution technique. While conducting the two set of experiments it was found

that the results varied with the concentration of antibodies or molecules we stain the cells in the

immunofluorescence protocol. After many trial and error, it was found that in imaging α tubulin, a

primary antibody concentration of 1:200 in 1% BSA-PBS and a secondary antibody concentration

of 1:700 dilution with 1% BSA-PBS , and an incubation time of 12 hours gives the desired rate

of fluorophore blinking with minimum background signal and autofluorescence. The dilution of

phalloidin conjugated Alexa Fluor 647 of 60 µl in 800 µl PBS incubated for 10 hours gave the best

results. An incubation of over 10 hours showed to have excessive fluorescence thus generating

much background signal and poor STORM reconstructions.
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The astigmatism method we employed to expand the STORM technique to 3D capability poses

a limited z range of 1 µm (-550 nm on one side and 550 nm on the other side). A spermatid cell has

a width of around 3 µm, thus our imaging set-up was limited to obtaining about 1/3rd of the cell.

This can be overcome using Tetrapod PSFs that outlines a tetrahedral shape in 3D as a function

of the axial position of the fluorescing molecule [71, 72]. It has been optimized for single emitter

localization by Fisher information maximization. There are two lobes to the tetrapod PSF that is

separated by a distance that varies as a function of the emitter depth [73]. Depending on whether

the emitter is above or beyond the focal plane, the axis along the separation of the two lobes rotates

90◦. Experiment in Nehme et.al [74] used a Convolutional Neural Network (CNN) that optimally

localizes the PSF and achieved an axial range of 5 µm. A phase mask is placed in the emission

path of the microscope to encode each of the 3D point source to low-resolution 2D image. The

CNN receives this 2D image of overlapping tetrapod PSFs and output a 3D grid that translate to

3D localizations.

In addition, multi-color imaging can be done by spectral demixing where two fluorescent

probes are excited by the same laser wavelength and the overlapping emissions are seperated by

dichroic splitter. Experiments [75–77] have used Alexa 647 and 700 as photoswitchable probes and

band pass emission filters along with splitter dichroic to optimize crosstalk for spectral demixing

and obtained separate populations of localization pairs. Extending that idea to this project would

produce overlapping imaging of F-actin and tubulin, thus confirming that they are co-localized

in the manchette structure. It can be also done by double labelling primary antibodies with an

activator-reporter pair. The activator facilitates the photo-activation of the reporter, switching it

between fluorescent and dark states by light of different wavelengths [78].
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Appendix A

Coating coverslips with Poly-L-lysine

This protocol is used for coating coverslips with Poly-L-lysine to promote adhesion of cultred

spermatid cells onto coverslips

Materials:

• 1.5 ml centrifuge tubes

• Acetone

• Ethanol

• Deionized water

• 10% Poly-L-lysine

• 22x22 square coverslips

• glass coverslip holder

Procedure:

1. Wash the coverslips with acetone. Sonicate for 5 to 10 minutes.

2. Pour out the acetone and wash with ethanol. Sonicate for 5 to 10 minutes.

3. Pour out the ethanol and wash with deionized (DI) water. Sonicate for 5 to 10 minutes.

4. Pour out the DI water and wash with 10% Poly-L-lysine in DI Water. Incubate for 5 minutes.

5. Pour out the solution. Transfer the coverslips to a dry coverslip holder and dry them in an

oven for 1 hour.

6. Use the coverslips the same day.
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Appendix B

Preparing GLOX

The protocol is for the preparation of GLOX. It is a component of the imaging buffer added to

sample before imaging. It is an oxygen scavenger and removes oxygen to prevent photobleaching.

Since the enzymes oxidase and catalyze leads to acidification of the buffer over time, GLOX has

to be prepared fresh every two weeks.

Materials:

• Glucose Oxidase from Aspergillus niger-Type VII, lyophilized powder,≥ 100,000 units/g

solid G2133- 250KU [Sigma-Aldrich]

• Catalase from bovine liver -lyophilized powder, ≥10,000 units/mg protein # C40-100MG

[Sigma-Aldrich]

• Buffer A : 10 mM Tris (pH 8.0) + 50 mM NaCl

Procedure:

1. Measure the glucose oxidase. 14mg of oxidase gives 250 µl of GLOX solution.

2. Measure catalyze and make a dilution of 17 mg per 1 ml DI water. Add 50 µl of this for 250

µl GLOX.

3. Add 200 µ of Buffer A for 250 µl GLOX.

4. Use the GLOX solution within two weeks.
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Appendix C

Collecting and fixing spermatid cells from mice

Spermatids are collected from at mice that is at least 5 weeks old. Sample preparation and cell

fixation steps are listed in the protocol.

Materials:

• DNAse (StemCell 07469): stock buffer, 1 mg/ml in PBS

• Collagenase type IA (Sigma C9891)

• Dulbecco’s Modified Eagle Medium (DMEM) #21063 [Invitrogen]

• Phosphate-Buffered Saline (PBS), 1×

• Sucrose

• Paraformaldehyde

Procedure:

1. Prepare isolation buffer for spermatids by mixing 5 µl of DNAse, 5ml of DMEM and 2.5 mg

of collagenase in a conical tube.

2. Add 1 ml DMEM to an eppendorf tube and store on ice.

3. Euthanize a mouse of at least 5 weeks age and collect testes. Store the testes in the 1 ml

DMEM solution.

4. Make a small vertical cut to each testis and squeeze the contents out using a tweezer into the

isolation buffer.

5. Incubate the sample at 32◦C for 30 minutes. Gently pipette the solution every 8 minutes

during this incubation time to break the tissue but not the cells.
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6. Centrifuge the sample at 1000 rpm for 5 minutes at 4◦C. Aspirate the supernatant and add 5

ml PBS to the sample and shake gently to suspend the sample in PBS.

7. Repeat the step 6. Follow the protocol for the respective protein.

A) Tubulin:

8. Centrifuge the sample once again at 1000 rpm for 5 minutes and add freshly prepared fixative

solution made of 0.1M Sucrose and 4% Paraformaldehyde in PBS and shake gently for 15

minutes.

9. Centrifuge the sample at 800 rpm for 5 minutes at 4◦C. Aspirate the solution and wash with

5 ml PBS.

10. Repeat the step 8. Centrifuge again at 800 rpm for 5 minutes and add 2 ml PBS and suspend

the cells by gently shaking.

11. Check the cell density with a sample slide and adjust the dilution with PBS if necessary.

12. Transfer the cells to Poly-L-lysine coated coverslips. Draw a circle with oil pen on the

coverslips to make a hydrophobic boundary for the samples.

13. Pipette 50 µl of sample solution onto each coverslip. Wait for 25 to 35 minutes to allow the

samples to semi-dry. Check by tilting the coverslips. The sample should not have solution

running or dry. From this step make sure that the samples do not get dry.

B) Phalloidin

8. Centrifuge the sample once again at 1000 rpm for 5 minutes and add 2 ml PBS and suspend

the cells by gently shaking.

9. Check the cell density with a sample slide and adjust the dilution with PBS if necessary.
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10. Transfer the cells to Poly-L-lysine coated coverslips. Draw a circle with oil pen on the

coverslips to make a hydrophobic boundary for the samples.

11. Pipette 50 µl of sample solution onto each coverslip. Wait for 25 to 35 minutes to allow the

samples to semi-dry. Check by tilting the coverslips. The sample should not have solution

running or dry. From this step make sure that the samples do not get dry.
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Appendix D

Labelling the cells- Immunostaining protocol

The protocol discusses steps in immunostaining protocol for tubulin, and Alexa 647phalloidin

to stain the cytoskeleton by binding to actin. The tubulin immunostaining follows indirect

labelling.

Materials:

• Goat serum (VWR 101098-382)

• Phosphate-Buffered Saline (PBS), 1×

• Triton X-100

• Bovine Serum Albumin

• α tubulin - primary antibody

• anti-rabbit - secondary antibody

• 2-Mercaptoethanol # 63689-100ML-F [Sigma-Aldrich]

• Buffer B : 50 mM Tris-HCI (pH 8.0) + 10 mM NaCl + 10% Glucose

• GLOX solution (250 µl)

• Gluteraldehyde

• Cytoskeleton buffer

• Sodium Borohydride - NABH4

Procedure:

A) Tubulin:

53



1. Permeabilize the cells with 1% Triton at room temperature for 5 minutes .

2. Wash the samples with 100 µl PBS three times without wait time in between.

3. Prepare blocking buffer with 10% Goat serum in PBS, 3% BSA and 0.2%Triton. Add 100

µl to each coverslip and incubate for 1 hour.

4. Prepare primary antibody solution of 1:200 dilution of α tubulin in 1% BSA in PBS and

10% Goat serum. Add 100 µl onto each coverslip.

5. Store the samples in an aluminum foil box overnight in a moisture chamber at 4◦C.

6. After 12 hours of overnight incubation, wash the samples with 100 µl PBS three times with

10 minutes wait time.

7. In a dark room, prepare the secondary antibody solution of 1:700 dilution of anti-rabbit with

1% BSA in PBS and 10% Goat serum. Add 100 µl onto each coverslip and incubate for 1

hour at room temperature. From this step, make sure that the samples are not exposed to

light.

8. Wash the samples with 100 µl PBS three times with 10 minutes wait time.

9. If not used immediately, store the samples in 100 µl PBS at 4◦C until ready to be imaged.

10. Before imaging, aspirate the PBS solution from the samples and add 4 to 5 µl of imaging

buffer made of 690 µl Buffer B, 7 µl of 2-mercaptoethanol and 7 µl of GLOX.

11. Mount the coverslip on a slide and image immediately.

B) Phalloidin:

1. Fix the cells with 0.3% glutaraldehyde and 0.25% Triton in Cytoskeleton Buffer (CB) for 2

minutes.

2. . Wash the samples with CB thrice with 5-minute wait time in between.
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3. Add 100 µl of 2% glutaraldehyde in CB and wait for 15 minutes.

4. Wash with CB twice with a wait time of 10 minutes.

5. Add 100 µl of freshly prepared 1% NABH4 in PBS and incubate for 7 minutes.

6. Wash with CB twice with 5-minute wait time in between. 7

7. Prepare a fresh Phalloidin solution by adding 60 µl of Alexa Fluor-647 for Phalloidin and

800µl of PBS and add 100µl to each sample.

8. Store the samples in an aluminum foil box overnight in a moisture chamber at 4◦C.

9. After 10 hours of overnight incubation, wash the samples with 100 µl PBS three times with

10 minutes wait time.

10. If not used immediately, store the samples in 100 µl PBS at 4◦C until ready to be imaged.

11. Before imaging, aspirate the PBS solution from the samples and add 4 to 5 µl of imaging

buffer made of 690 µl Buffer B, 7 µl of 2-mercaptoethanol and 7 µl of GLOX.

12. Mount the coverslip on a slide and image immediately.
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Appendix E

Protocol for aligning a TIRF microscope

The imaging set-up uses TIRF microscope. The laser and microscope has to be aligned before

every experiment to obtain good quality images. The protocol discusses the alignment of red

laser beam. Violet laser (405 nm) is also used in the experiment for the purpose of reactivating

flurophores.

(A) Aligning a LASER

Figure E.1: Components of TIRF microscope.

Fig E.1 shows the components of the red laser in the TIRF room. The path of the laser beam is

marked on the table, and it travels from the laser cavity to the microscope in the order in which the

components are numbered in the protocol.

1. LASER- The laser emits light of wavelength 641.5 nm.

2. SHUTTER- This can be operated manually or through NIS elements software. An ND filter

can be placed while aligning to reduce the intensity of light, but it must be placed at an angle such

that the reflected beam does not travel back into the laser cavity.
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3. MOVABLE MIRROR PAIRS- On the table, place the first mirror such that the laser beam

reflects off its center and the mirror is angled at 45 degrees to its stand. Use an aperture for this

alignment. Now place the second mirror such that the beam hits the center of the mirror and is also

laterally and vertically aligned at all points between the two mirrors. Use a tall stand with a sticky

note to check the alignment. If you notice that the beam is shifting, move the second mirror to a

better location and use the knobs on the first mirror for fine adjustments.

4. TELESCOPE- Once the beam is aligned until the telescope, laser beam should be centered

at the first telescopic lens. Use apertures to ensure that the beam is centered and that it maintains

the same height and lateral position. Also check for reflections and make sure they align with the

laser beam on the lens. Place the second lens of the telescope such that the distance between the

lenses is the sum of their focal lengths. For alignment, use the knobs on the xyz stand that the

second lens is mounted on.

The beam emerging from the telescope should be collimated. If the beam appears to be shrink-

ing, the lenses are too far and if the beam expands, the lenses are too close together. Once the beam

is collimated and is aligned laterally and vertically, move to the next step.

5. ALIGNING MIRRORS- To allow multiple lasers to illuminate the microscope, the LASERS

follow the same path from the set of dichroics to the microscope as shown in Fig E.2. This protocol

will refer to this section of shared path as the “main line”. The alignment microscope allows this

shared path by aligning the beam along the main line.

The first aligning mirror should be placed such that it is at 45-degree angle to its stand and the

beam is centered. The beam should be collimated and aligned at all points between the mirror and

the second telescopic lens. If not, go back to section 4. The second mirror should have the beam

centered and follow the alignment and collimation conditions. Use the knobs on the first mirror to

make any fine adjustments.

6. DICHROIC-The dichroic passes only a specific wavelength. The beam should be centered

at the dichroic as well.

(A.1) Aligning the “main line”:
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Figure E.2: The shared path of LASERs – “main line”

Due to drifts, the laser alignment may vary, especially at the main line and should be re-adjusted

before imaging.

a) Remove the first steering mirror and the two telescopic lenses of the second telescope before

aligning the laser through the main line.

b) There are two apertures in the main line as marked in Fig E.2. The steering mirror diagonal

to the aperture is used to align the beam through it, that is, the aligning mirror on the right side of

the table (next to the first telescope) in Fig E.1 is used for near aperture and the aligning mirror

on the left side (before the dichroic) aligns the laser beam at the far aperture. If you see that the

alignment gets only worse after a few iterations, switch the aligning mirrors- mirror on the left for

near and the one on the right for far.

Use the right aligning mirror to center the beam at the near aperture. This will move the beam

farther from the far aperture. Center the beam at the far aperture using the left aligning mirror. That

will cause the beam to go off -center at near aperture. Adjust the aligning mirrors in this manner

until the beam is centered at both the apertures.

7. SECOND TELESCOPE- Place the telescopic lenses such that the laser beam is centered at

them both, aligned at all points between them and the lenses are at a distance equal to the sum of

their focal lengths. Check for collimation and adjust the length of the telescope accordingly.
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Once the beam appears to be collimated and aligned throughout the table, place the first steering

mirror back such that the beam is centered on it. Remove the focusing lens from its stand and

proceed to the next step.

(B) Aligning the microscope

a) Place an SM1 tube with an aperture on each end, on the objective holder to align the laser

beam along the microscope.

Figure E.3: Positioning the crosshair for reference

8. STEERING MIRRORS- The first steering mirror aligns the bottom aperture of the tube,

and the second steering mirror aligns the top aperture. Close the near aperture in the main line to

reduce the size of the beam.

b) Open and close the bottom aperture and check if the beam is centered and opens and closes

uniformly. If not, you will see that one side of the beam disappears and appears earlier than the
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Figure E.4: Laser beam in close to TIRF

other sides and the center of the beam is not at the exact center of the aperture. Use the knobs on

the first aligning mirror to center the beam at the bottom aperture.

c) Follow the same steps for aligning the top aperture and repeat the process until the beam

passes through the center of both the apertures.

d) Once the apertures appear to open and close uniformly, place a piece of paper with a

crosshair marked such that it is centered at the beam (red dot on Fig E.3) and do not move the

paper afterwards as it is the reference to the desired position of laser beam.

e) Keep the focusing lens back in its position and replace the SM1 tube with a 100X objective.

9. FOCUSING LENS – Place an aperture on the focusing lens during alignment. The lens is

placed on a micrometer that can be moved in the xyz direction.

f) Adjust the position of the focusing lens such that the beam is centered on it and its reflection

aligns with the beam on the second aligning mirror.
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g) Use the micrometer knobs to center the beam on the ceiling back to the crosshair. The beam

will now be off center at the focusing lens but do not move the focusing lens or its knobs.

h) Use the first steering mirror to re-center the beam on the focusing lens. This will move the

beam away from the crosshair. Use the second steering mirror to center the beam on the crosshair.

Repeat these steps until the beam is centered at the focusing lens and at the crosshair.

i) Now use the knob at the side of the micrometer to move the laser beam towards the micro-

scope to bring to ’close to TIRF’. Position it at the slide stand as shown in Fig E.4. The TIRF

microscope is now aligned.
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Appendix F

3D STORM Calibration Protocol

The protocol is used to prepare the calibration samples and perform the calibration experiment

for MicAO optical optimization, and for obtaining the look up tables for 3D STORM reconstruc-

tion.

F.1 Preparing Calibration sample

Materials:

• 0.1 µm TetraSpeckTM fluorescent microspheres (Invitrogen 2155302)

• Acetone

• Ethanol

• Deionized water

• Phosphate-Buffered Saline (PBS), 1×

• 1.5 ml centrifuge tubes

• 22x22 square coverslips (Poly-lysine coating recommended)

• 75X25 Glass slides

• Fast dry nail polish

• Aluminum foil covered petridish

Procedure:

1. Clean coverslips using Acetone, ethanol and DI water as discussed in the first three steps of

Appendix A- Coating coverslips with Poly-L-Lysine protocol.

2. In a centrifuge tube dilute Tetraspeck beads in 1:1000 dilution in PBS.
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3. Sonicate the centrifuge tube.

4. Pipette 500 ml of the prepared sample 2onto a cleaned coverslip and incubate for 5 minutes.

5. Aspirate the beads solution leaving 15 to 30 µl on the coverslip.

6. Place the coverslip on the center of a slide using a tweezer, making sure that you place the

sample side down on the coverslip. Gently press down the coverslip with a Kimwipe. Seal

the edges with nail polish.

F.2 Calibrating the MicAO

1. Turn on the cooling system for the camera and then turn the camera, MCL Piezo and ASI

on.

2. Open MicAO local and choose the baseline mirror shape file- closedloopCasao.has, from

installation files.

3. Open NIS Elements and choose the imaging settings as shown in fig F.1 and ensure that the

file path is correct. Save the images as Tiff files.

4. Select Time series under Acquisition tab and ensure that the imaging delay is 450ms, the

Run Duration is continuous, and macro settings is in ‘Execute after every phase’ as shown

in fig5.

5. Allow the system to warm up for 15 minutes.

6. In MicAO, open the Diagnostics tab to see the PSF of any selected bead.

7. Under Optimizations, choose Focus, D3th order spherical aberration and D5th order aberra-

tion, as shown in fig F.2.

8. Turn off the laser using shutter in NIS Elements, put an ND2 filter in the path of the red laser.
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Figure F.1: Imaging settings for obtaining PSF
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Figure F.2: MicAO settings to obtain PSF without aberrations

9. Put a drop of objective oil on 100x objective and turn off the light. Put the calibration sample

(coverslip down) under the microscope and secure with slide clips. Bring the objective up

until the oil interacts with the sample.

10. Set the exposure to 15ms and gain to 10 and turn on bright field light.

11. Find the surface by turning the focusing knobs of microscope and locating the position with

maximum brightness.

12. Turn off the bright field light and set the exposure to 400ms and gain to 7. Click on Green

play button in NIS Elements for live image window.

13. Locate an isolated bead with good fluorescence.

14. Adjust the ROI around the bead to 50x50 pixels and focus the bead.
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Figure F.3: Gain and exposure settings for calibration

15. Adjust exposure between 400 to 450 ms and gain until the bead is not saturating but the

histogram is utilized maximum as shown in fig F.3.

16. Under Acquisition, click on ‘Run Now’ and click on the yellow play button in MicAO to

obtain PSF. Click on green checkmark after the optimizations are completed.

17. Compare the final contrast with the initial contrast. Check the PSF to see if it has improved.

If it has and the final contrast is lower, the bead may be bleaching. If the bead is bleaching,

move on to the next bead and repeat step 12 to 15.
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18. Repeat steps 15 and 16 until the PSF is clean and spherical and the current optimization is

not improving much. Make sure that the pistons in MicAO are not maxing out to -1 or +1 by

checking mirror shape as shown in fig F.4.

Figure F.4: Mirror shape in MicAO

19. Under Optimizations, select all options from Focus to Trefoil at 90◦ as shown in fig F.5.

Repeat steps 12 to 17.

20. Once the PSF looks good, save the mirror shape file. Now select the mirror shape file you

just saved and click on apply.

21. Select the Open Loop tab in MicAO and click on yellow play button. It will turn to a green

check mark. Change the Astigmatism settings to -0.06 um as shown in Fig F.6.

22. Check the astigmatism of a bead by adjusting the focus. The bead should be in a perfect

plus sign when in focus, as shown in fig F.7 a. When turning the focusing knobs, it should

elongate and shrink only in horizontal in one direction of focus, as in fig F.7 b and only in

vertical in the other direction of focus, as in fig F.7 c.
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Figure F.5: Settings for obtaining PSF

Figure F.6: Astigmatism settings in MicAO

23. If the astigmatism does not look good, repeat steps 7 to 21 with a reference mirror shape that

has worked well before.

24. Turn off the laser. Remove ND2 from the laser path. Change the imaging path and deselect

Tiff option.
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(a)

(b) (c)

Figure F.7: Checking the PSF of beads (a) Beads in focus (b) Beads elongated horizontally (c) Beads
elongated vertically
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Figure F.8: Settings to capture calibration movies
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25. Select only Z series option and make sure the settings are as shown in fig F.8.

26. Locate a group of 5 to 10 beads that are not overlapping but are close in proximity and draw

and ROI around the group.

27. Adjust exposure between 400 to 450 ms and gain until the bead is not saturating but the

histogram is utilized maximum as shown in fig 7. Click on ‘Run Now’ and note down the

gain and exposure values for reconstruction.

28. Repeat steps 25 and 26 until you have about 10 good calibration movies.
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Appendix G

Finding and imaging spermatid

The protocol is used to find spermatids on the sample and discusses the settings to obtain

movies. The protocol uses the mirror shape and astigmatism settings from Appendix F.2 Calibrat-

ing the MicAO protocol.

1. Select Time series and make sure that the settings is ‘No Delay’ and 50000 loops, and the

Advanced setting is deselected, as shown in fig G.1.

Figure G.1: Time series settings for imaging cells
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2. Open ASI console. Under MS 2000, select Connect, as shown in fig G.2 a. Click CRISP

under ‘More’ options and the dialogue box will open as shown in fig G.2 b.

3. Turn on Violet laser and choose the filter 5 (no light passes through) from Thorlabs FW102C.

4. Set the exposure to 15ms and gain to 10ms. Turn on the bright field.

5. Clean the 100x objective and add fresh oil drop. Place the sample as done for calibration.

6. Locate the surface as explained in the ’Calibrating the MicAO’ protocol.

7. Find a spermatid in stage 10 to 14. Make sure that the cell is on the bottom of the cover slip

by checking the focus in and out of the cell. Select ROI of maximum 99px height to reduce

the image capture time.

8. Turn off the brightfield and turn on the laser. Adjust the gain to a maximum of 300. Adjust

the focusing knobs such that you can see blinking and the fluorophores are focused (plus

sign).

9. a) Once the cell is focused, click on Step 1 in ASI CRISP dialogue box, as seen in fig 14b.

Turn the silver knob in the Autofocus box and check the LCD display of ASI MFC-2000 to

get the largest ‘Sum’ and least negative error. Refer fig G.3. Click Step 2 and then click on

Step 3. Click Lock. The focal plane should be the same as you had set.

b) If it is not, or if the ASI maxes out to +0.5 or -0.5 in z, click Unlock and use the black

knob on ASI MFC-2000, as seen in fig 15, to find the focusing plane again. Repeat step 9a.

10. Turn off the red laser. Turn on brightfield and take a picture of the ROI. Name it BFBefore

(bright Field Before).

11. Turn off brightfield and put an ND2 filter in the laser path. Turn ON red laser. Take a picture

of low fluorescence and name it Fluor.

12. Turn off the laser. Remove the ND2 filter from the path and turn on the laser. Click Run

Now.
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(a)

(b)

Figure G.2: a) ASI home window (b) CRISP settings to adjust autofocus
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Figure G.3: ASI MFC 2000

13. Pay close attention to the ASI LCD display to see if it maxes out or is rapidly changing in

z. Check the blinking in the live image window. If the rate reduces, change the filter in

FW102C to filter4, and if needed increase to filter 3 and then filter 2 later.

14. After the 50000 frames have been collected, turn off the laser. Switch the violet laser filter

to filter 5. Reduce the gain to 10. Turn on bright field and take a picture. Name it BFAfter

(Bright Field After).

15. Move the slide to an isolated area with no particles on the coverslip and take a picture of the

ROI to subtract background noise from BFB. Unlock the Autofocus.
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16. Repeat steps 7 to 15 until its 2 hours after the imaging buffer was added to the sample.

17. Prepare a new sample and repeat steps 4 to 16.
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Appendix H

Obtaining look up tables for Astigmatism method

This protocol makes use of ImageJ software to obtain the look up tables from the calibration

movies obtained. ImageJ produces .yaml files based on the settings selected for reconstruction. The

.yaml file that gives the best sigma curve is selected as the look up table to run the 3D reconstruction

of spermatid movies.

1. Install NDi6 plug-in for ImageJ.

2. Select Plugins>NDi6>ND to Image6D and choose the ND2 file from the path.

3. Export the 201 frames (.tiff) to the desired path. Refer to fig H.1

4. Click File>Import>Image sequence

5. Select frames 30 to 170 and drag and drop them to the drop-down window as seen in fig H.2.

6. Check the ‘Visual stack’ box. Select Plugins> ThunderSTORM> 3Dcalibration> Cylindrical

lens calibration, as shown in fig H.3.

7. From the new window, select Camera set up. Refer fig H.4. For the TIRF set up in Krapf

lab, the Pixel size in nm is 130, Photoelectrons per A/D count is 16.23773, Base level A/D

counts is 6.437. Type in the EM Gain for the calibration movie. Click on OK

8. For the rest of the settings, refer fig H.5. Click on Image Filtering, select Wavelet filter with

B-spline order 3 and scale 2.0 from the drop-down menu.

9. Select ‘Local maximum’ as Method under Approximate localization of molecules and con-

nectivity as 8-neighbourhood.

10. Select ‘Elliptic Gaussian w/angle’ under sub-pixel localization of molecules
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(a)

(b)

Figure H.1: (a)Exporting to .tiff files. (b) Path to which files were exported

11. Choose Fitting radius[px] as 6, Fitting method as Least squares and Initial sigma[px] as 0.93.

Choose 3D defocusing curve as ThunderSTORM.

12. Enter z stage step[nm] as 10 and z stage limit[nm] as 550.

13. Enter Peak intensity threshold as 1*std(Wave.F1) and click on Preview.

14. Check the beads in the preview and see if each of them has a single plus sign at its center.

If there are plus signs in the background where beads are not present, as seen in fig H.6 a),

increase the threshold value to 1.5, 2 and so on until only the beads are located with plus

signs, as shown in fig H.6 b).

78



Figure H.2: Importing tiff files for calibration

Figure H.3: Navigating to cylindrical lens calibration
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Figure H.4: Camera settings for calibration

Figure H.5: Settings to run 3D calibration

15. Choose ‘Save to file’ and choose the path to save yaml file, as shown in fig H.7.

16. Press OK to run the calibration.
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(a)

(b)

Figure H.6: Calibration preview (a) Calibration preview before adjusting the threshold (b) Calibration
preview after adjusting peak intensity threshold

17. Observe the Sigma curves and save them. Repeat the steps for all calibration movies. Choose

the one with the most symmetric sigma curves and is most centered at z. Refer fig H.8.
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Figure H.7: Path to save .yaml file

Figure H.8: Sigma curve
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Appendix I

STORM 3D Reconstruction Protocol

The protocol uses ImageJ software, and discusses the steps to obtain 3D reconstruction from

the spermatid movies collected according to the protocol in Appendix G- Finding and imaging

spermatid. The LUT from Appendix H- Obtaining look up tables for Astigmatism method, is used

in this protocol.

1. Drag and drop the .nd2 file to ImageJ toolbar. Click OK on the window opened as shown in

fig I.1.

Figure I.1: Importing data to ThunderSTORM

2. Select Plugins>ThunderSTORM> Run analysis as shown in fig I.2.
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Figure I.2: Path to Run analysis

3. Set the parameters in camera set up as shown in fig I.3, and type in the gain you had recorded

while imaging.
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Figure I.3: Camera setup for reconstruction

Figure I.4: General settings for 3 D reconstruction

4. Refer fig I.4 for the Run Analysis settings. Choose Wavelet filter (β spline) as imaging filter

with order 3 and scale 2. Approximate localization of molecules: Select method as local

minimum. The peak intensity threshold can be any value from 1. Use ‘preview ‘ to choose

the best value or set it as 1. The connectivity is 8-neighbourhood.
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Figure I.5: Normalized Gaussian

5. Sub pixel localization of molecules: Since we are running 3D localization with astigma-

tism method, choose Elliptical Gaussian:3D astigmatism as the method, with fitting radius

3 and initial sigma 0.87. The initial sigma value depends on the emission wavelength of

fluorophores, numerical aperture of the objective, pixel size of the system such that , Initial

Sigma[px]= 0.25*λemission/(NA*pixel size). Since Alexa 647 has an emission wavelength

of 671 nm, numerical aperture of the objective is 1.49 and pixel size is 130, initial sigma is

0.87 nm. Select the calibration file (.yaml or .txt) that gave the best sigma curve as discussed

in Calibration protocol.

6. Visualization of the results: Choose Normalized Gaussian as the method with a magnifica-

tion of 5 and update frequency (frames) as 50. Deselect Colorize z stack to reduce the time of
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processing. The z range is chosen as -550 to 550. The step size is pixel size/ magnification,

and hence is 130/5 = 26. Set axial and lateral uncertainty in nm as 10.

7. Click OK to run analysis. Normalized Gaussian window will open as seen in fig I.5, and the

50000 frames will be processed.

8. After the initial reconstruction , a table will be displayed as seen in fig I.6. Export this table.

It can be imported any time by going to Plugins>ThunderSTORM>Import/Export>Import

results.

Figure I.6: Preprocessing Look-up-table

9. First step in postprocessing is to remove duplicates. Click on Apply as seen in fig I.7. The

Post processing history section will show when that step is finished.
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Figure I.7: Removing duplicates from the initial reconstruction data

10. The second step is to filter out the range outside the calibration accuracy range of -550 to

550. To do this, click on Plot Histogram and choose z as the parameter, as shown in fig I.8.

Figure I.8: Plot histogram of reconstructed data

Figure I.9: z distribution of the reconstructed data
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11. A window will pop up as seen in fig I.9. Select the region with the highest peak and utilize

up to 550 on either side of the peak. Click on ‘Apply ROI to filter’

12. The z range will be reflected in the Filter section. Click on Apply and the Restrict to ROI.

The post-processing history section will reflect the changes as shown in fig I.10.

Figure I.10: Coarse z filtering

13. Click on visualization to view the stacks of reconstruction in each z height. Select Auto

size by results to visualize Normalized Gaussian of truncated data. Click on ’Auto size by

analysis’ to view the Normalized Gaussian with the same pixel width and height as the .nd2

movie. Select colorized z stack. Refer fig I.11.

Figure I.11: Visualization of filtered data with stacks in different z height
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14. The next step is drift correction. Since there are no beads used in imaging the spermatids,

choose Cross correlation method. On clicking » a window will open as seen in fig I.12 a.

Choose number of bins as 5 and keep the magnification at 5. Observe the x and y drifts. If

they are not monotonously increasing or decreasing, as seen in fig I.12 a, reduce the number

of bins to 4, 3 and so on until they are, as seen in figure I.12 b.

15. Apply Density filter to the data to reduce the background noise. Choose the distance radius

in nm as 25.0 and the maximum number of neighbors in the radius as 2. Refer fig I.13. These

values may be adjusted after previewing the reconstructed data to obtain least noise.

16. The last step is to merge the data. Click on the Merging tab and select Merge, as shown in

fig I.14.

17. Export the post processed data to the desired folder for future reference. Refer fig I.15.

18. Click on Visualization and choose Auto size by analysis. Save the Normalized Gaussian

stack of images as .tiff file, as shown in fig I.16. Click on Image>Type>RGB.

19. Select Image>Stack>z project to see the z projection or select Image>Stack>3D projection

to see the rotation movie. Refer fig I.17 for the 3D projection settings.

20. Add scale to the z projection or 3D projection by selecting Analyze> Set scale and then

choosing Analyze>Tools> Scale bar. Refer to fig I.18a and I.18b.
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(a)

(b)

Figure I.12: Drift correction (a) xgraph with x drift going from positive to negative slope (b) x and y drifts
monotonously decreasing
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Figure I.13: Density filter settings

Figure I.14: Merging of post processed data

Figure I.15: Exporting post processed data
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Figure I.16: Exporting post processed stack of data viewed as Normalized Gaussian as .tiff file

Figure I.17: 3D projection settings
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(a)

(b)

Figure I.18: Adding scale bar (a) Setting scale parameters (b) Settings to place the scale bar

94


